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本章导读

AutoCAD 的绘图功能有很多种，本章主
要介绍一些基本的平面绘图命令及其各种功
能，并配以适当的例子加以说明，让初学者
有一个大致的概念，熟悉 AutoCAD 绘图的环
境。尽管这些命令都很简单，但很实用，在
以后的各章节中要经常用到。对 AutoCAD 较
熟悉的读者可跳过该章。在讨论菜单和命令
时，本章采用一个箭头表示下拉级数。例如，
选择 View →Zoom →All 的意思是从 View菜
单中选择 Zoom 子菜单中的 All 命令。对于新
版的 ACAD2000，这些基本命令的菜单方式
更友好，读者可以根据具体情况运用，在本
章中也有较详细的介绍。



例 解例 解
扳手是日

常生活中用到

较多的工具，

在这里主要是

通过画扳手介

绍一下画圆的

一种方式，即

“TTR”方式。

画圆有几

种方式，“ T

TR”是输入半

径后，再选择

切点，从而得

到 所 要 画 的

圆。

用 Layer

命令设置图层

和线型，按照

右图中的对话

框设置各项参

数。将线型设

置好后，将 0

层设置为当前

层，此时线型

是 Center 型。

用 Line 命令画

中心线，然后

根据中心线的

位置画出其他

的实体。注意，

单击右键时，

会出现一个菜

单，选择其中

的“Enter”键

会结束命令，

这与 R14 不

同。

1  首先用 Layer 对话框设置图层及线型，Layer 对话框将在第二章详细

介绍。在 Command 后键入 layer，出现 Layer 对话框，当点击 Layer 对话框中

“Linetype”下的内容后，出现下列对话框。

2  点击上图菜单中的“Load”键，出现下列对话框，如下图所示。用鼠标选

择对话框中的“Center”线型，这样就可以设置好线型。

3  单击“OK”键后，将线型设置为“Center”线型，用 Line 在作图区上画

出一条中心线。具体的各点坐标见下面，按照提示输入即可。

Circle(画圆)
扳  手



画扳手的

主杆时要用到

画圆命令，可

以选用“TTR”

方式。这里只

介绍画圆的这

种方式，这种

方式在工程绘

图 中 极 为 有

用，例如，对

于画那些只给

出相互位置关

系而无坐标的

图形，只能用

这 种 方 式 来

画，否则得到

的结果不对。

用这种方式尤

其要注意的是

顺 序 不 要 弄

错。当然，也

可以用 Mirror

命令将上面的

圆镜像到下面

得到同样的结

果，正所谓条

条 道 路 通 罗

马。第六步的

标 注 是 先 用

Dim 命令进入

Dim 状态，再

标注。用标注

命令时一定要

先进入 Dim 状

态。

4  画完中心线后，将线型设置为 Continuous型，实际上将图层设为 0 层后即

可，然后用 Line 命令和 Circle 命令画出下面的图形，供画扳手用。注意

各点的坐标。

5  然后用画圆命令在作图区上画四个圆相切，用“TTR“方式。在 Command

后键入 Circle 命令后，在 3P/2P /TTR/<Center point>:后键入 ttr，然后选取

左上方的圆，再选取上方的直线，回车，得到与所选两实体相切的一个圆。

6  当画完主体部分后，用 Trim 命令将多余部分剪切掉。画扳手口时，先画

两条平行直线，然后用始终点及半径式画弧。在 Command 后键入 Dim，

再在 Dim后键入 Hor命令，选取两个圆心后得到标注图示。

7  总结：画扳手用的命令是比较基本的，但要注意，只有当两线相交时，用

Trim 命令才有效。

画直线按钮



例 解例 解

             

               

  

Circle 的

绘 制 有 好 几

种，包括 (cen,

rad)(圆心，半

径 ) ， 3P( 三

点 ) ， 2P( 两

点 )， TTR(画

公切圆)。本实

例将之综合，

以体现出绘圆

的多样性。

用画圆命

令 时 是 在

“Command:”

下键入“ Cir-

cle”。TTR 方

式画圆在前面

已经介绍过。

这种方式常用

于画一个与其

它实体相切的

圆，其它实体

可以是直线，

还可以是圆、

椭圆等实体。

用这种方式画

圆极为方便。

除了“ T

TR ” 方 式 以

外，还有三点

画圆方式，即

“3P”方式，

它用于已知三

点的位置而要

画圆的情况。

1  Line(画直线) 有几种方式，下面用菜单方式。点击 Toolbars中的 Draw，

出现“Draw”对话框，点击 ，即可画直线，下面用 Line 命令画台阶。

各点都是用鼠标在作图区内直接选取。

2  在“Command:”下键入“Circle”，用其 TTR方式画一圆与台阶相切,在提

示下用鼠标选第一和第二相切物体，分别为图中与圆相切的两条边，并输

入一半径，本例取缺省值。

3  再画一圆与第一圆及台阶相切，方法同上。

画圆按钮

Circle(绘圆)
台阶上垒加的球



菜单上的

绘 圆 方 式 是

(cen,rad) ， 所

以，要想熟练

掌握 Circle 命

令 ， 需 学 会

“Command:”

下的命令。

TTR 是

Circle 命令之

中的画相切圆

的方式，在选

相切实体时，

鼠标单击大致

的切点位置，

并输入半径。

画圆有几

种方式，这些

方式要熟练掌

握，对于不同

的情况有不同

的方法。点击

不同位置，相

切方式不同。

其 中 3P

方式是用鼠标

或者直接输入

三点的位置，

就可以作出圆

的图形。对于

本例是直接用

鼠标点击作图

区上的位置而

得三点。

4  在前三步的基础上画第三圆与前两圆相切，以圆代替球，可得到台阶上垒

放的球的图示。此时的画法与第二步一样。

5  圆与圆除了外切方式，还有内切方式。用 Circle 命令先绘两圆，用三点方

式及圆心半径方式绘制。用 3P及(cen,rad)方式绘制的两圆见下图。

6  选 Circle 中的 TTR，TTR 是 Circle 命令中的画相切圆的方式，在选相切实

体时，先用鼠标单击大致的切点位置，然后输入半径 20，回车后得到下列

图形。

7  总结：画圆的几种方式都很重要，这些方式要熟练掌握，对于不同的情况

要能随机应变。



例 解例 解

             

               

  

Polygon(多

边形)主要绘制

圆的内接正多

边形和外切正

多边形，其方

法比较简单，

但 若 恰 当 应

用，比较实用，

常用于其绘制

对称的图案。

其位置在

View→  Tool-

bars →  Draw

→Polygon（视

区→工具栏→

画图→正多边

形）。

用 Poly-

gon 命令画多

边形时，要注

意设置好边数

和对称中心，

最 少 是 三 条

边。将它与其

它命令结合起

来还可以画其

它图形，例如

五角星。

在输入圆

心时，可以用

Object snap 捕

捉圆心，也可

以直接输入，

本 例 是 用 前

者。

1   Circle 的绘制有好几种，包括(cen, rad)(圆心，半径)，3P(三点)，2P(两点)，

TTR(画公切圆)。可以用 Circle 中(cen,rad)画圆，取 R 为 25。执行过程及

画得的结果如下。

2  调用 Polygon,选内切圆方式，用 Object snap中的捕捉圆心选所画圆的圆心，

Sides设为 3，画三角形。执行过程及画得的图形见下面。

3  以同样的方式，用 Circle 中(cen,rad)画圆，画第二个圆，圆心为第一圆圆

心，圆心到三角形定点距离为半径。本例直接用鼠标选取点给出半径的大

小，所得的图形如下图所示。

画圆按钮

捕捉圆心按钮

Polygon(多边形)
多套花纹



继续画三

角形，选内切

圆方式，这种

方式可以使所

画的三角形与

圆相切，这是

很 重 要 的 一

点，一定要注

意。

画多边形

有几种方式，

只要改变边数

可以得到不同

的正多边形。

用 Change

（改变）命令，

可以改变图形

的颜色、线型、

交点等各种性

质。用该命令

改变颜色可以

使图形更为美

观大方，得到

的 图 形 见 左

图。将 Polygon

命令与 Change

命令结合起来

使用，得到的

图形会更为美

观 。 注 意 用

Polygon 命令

时 有 一 些 技

巧，后面介绍

的五角星就是

用该命令画出

来的。

4  调用 Polygon命令，选内切圆方式，用 Object snap中的捕捉圆心选所画圆

的圆心，Sides 设为 3，画三角形。如此重复三次，可得一精美图案。图

案见下面。

5  用 Polygon和 Circle 画好多套花纹后，可以用 Donut 命令再画中心。

6  可以用 Change 命令，即“改变”命令在作图区中改变图形的性质。在

Command 后键入 Change命令，再用鼠标选取实体，然后输入 P，回车后，

输入 Color，再回车后输入 2。改变颜色设置，得到的图形见下图所示。

7  总结：画多边形有几种方式，只要改变边数可以得到不同的正多边

形。



例 解例 解
Rectang(矩

形)是一个简单

命 令 ， 位 于

Toolbars →

Draw → Re-

ctang（工具栏

→ 画 图 → 矩

形）之中。

当你熟练

掌握它时，你

可以画出很有

意思的图案。

本例用到

Multiline 命

令，要想绘制

一组平行线，

要用到 Multi-

line 命 令 。

Multiline 可绘

制一组平行双

线。

Rectang
（画矩形）命

令主要用来画

一些已经知道

对角点坐标或

者四个端点坐

标的矩形，注

意，在一些精

确的工程绘图

中一定要知道

详细的坐标，

否则画出的图

形不会精确。

1  要想绘制一组平行线，要用到 Multiline 命令。Multiline 可绘制一组平行双

线，用Multiline画平行线，使其等距。主要是用鼠标在作图区上选点。

2  Rectang(矩形)是一个简单命令，位于 Toolbars→Draw →Rectang。点击

Rectang 命令快捷键后，用鼠标在屏幕上选两点，即画矩形。用 Rectang

命令画整个大矩形，用鼠标选点，使图形封闭。

3  为了表示围墙中的小砖块，用 Rectang命令画小矩形，点击 Rectang命令快

捷键后，用鼠标在屏幕上选两点，即画矩形。左右两侧在竖直方向相间的

画小矩形。

画矩型按钮

Rectang(矩形)
红砖墙壁模型



当然，对

于一些不精确

的绘图，也可

以用鼠标直接

在作图区上直

接 选 取 两 个

点，作为矩形

的对角点。如

此 简 单 的 命

令，竟然得到

与实际较为符

合的图形，所

以不要忽视基

本命令。

用 Rectang

命令画一矩形

时，除了给出

对 角 点 的 坐

标，也可以用

到 Object snap

快 捷 键 选 择

点。

为了得到

红砖墙壁要用

到 Change 命

令。Change 命

令是一个用途

较为广泛的命

令，可以用它

来改变图形的

很多性质。

4  画完小矩形后，要用较大的矩形表示完整的砖块，同样用 Rectang 命令画

一大矩形，以表示一完整的砖块，在同一水平面上的小矩形间画较大矩形。

5  同样用 Rectang 命令画一大矩形，以表示一完整的砖块，使矩形在竖直方

向相错开，即得到红砖墙壁的模型，注意用鼠标选取各点的坐标。

6  为了得到红砖墙壁，要用到 Change 命令，即在 Command 后键入 Change,

然后选用其中的性质方式改变图形的颜色，可以用鼠标选取实体，输入 P，

回车后，输入 Color，回车后输入 3。得到的红砖墙壁见下面。

7  总结：Rectang 命令是一个比较简单的命令，但是用这个简单的命令可以

画出许多较好的图形来。



例 解例 解
Arc(圆弧)

命令有几种方

式：三 点式、

圆心两点式、

两点半径式，

均可在 Com-

mand下输入

参数，设置变

量。三点式是

输入三点；圆

心半径式是输

入圆心，再输

入半径；两点

半径式是输入

两点，再输入

半径。

用Arc中

的两点圆心式

画圆弧时，要

注意输入各项

参数的顺序，

当然根据提示

也能看出输入

参数的顺序，

但是在没有提

示的情况下，

也要注意这一

点。

当然，画

圆弧时，也可

以连续画，只

要在画完一次

后，连续两次

回车，就可以

继续画。

1  要画蝴蝶，要用到Mirror 命令，而蝴蝶为对称图形，要画一对称轴，用 Line

画一直线作为对称轴。直接用鼠标选取点作为对称轴的端点。

2  用 Arc 中的两点圆心式画圆弧，左键单击 Arc 菜单，单击取一点，在

Center/End/<Second>后键入 C，单击右键，然后给出终点。

3  按上述过程连续画弧，即得一个触角。每次画以前，单击右键，可连续画。

画圆弧菜单

Arc(圆弧)
蝴蝶图案



前面已经

讲到 Arc(圆弧)

命令有几种方

式：三 点式、

圆心两点式、

两点半径式。

用 Arc 中

的三点式画圆

弧，要注意操

作的顺序。左

键单击“Arc”

按钮，再在作

图区上单击取

一 点 ， 在

Center/End/

<Second>后输

入第二点的坐

标，回车后，

最后给出终点

坐标。

对所作的

图形进行修改

时 ， 可 使 用

Erase命令将不

需要的实体删

除掉。经常有

这样的情况：

在画一个实体

时，要先画一

些辅助实体，

以便于作图，

作完后须将辅

助实体删去。

4  用 Arc 中的两点圆心式画躯体。在对称轴上选始终点，圆心在对称轴外，

同样可画出其一个翅膀。

5  画完一只蝴蝶的一半后，要画整只蝴蝶。利用 Mirror 命令，将半只蝴蝶沿

对称轴得到整只蝴蝶，再用 Arc命令画躯体上的花纹。

6  现在对所作的图形进行修改，要用到 Erase 命令，用鼠标选取所画的对称

轴，用 Erase删去对称轴，即得一只蝴蝶图案。

7  总结：Arc 命令是一个比较简单的命令。用这个简单的命令可以画出许多

较好的图形来，要熟练掌握。



例 解例 解

             

               

  

在建筑上

经常要画一个

建筑设计的平

面图形。这里

主要以医院楼

底层平面为例

介绍 AutoCAD

在建筑设计上

的应用。

在画医院

楼 底 层 平 面

时 ， 要 用 到

Mline 命令，

先要用其中的

Width 方式，

将平行线的宽

度设置为 3，

然后用 Mline

命 令 画 出 图

框，注意其各

点的坐标。

各点的坐

标为：左上角

(0,100)，左下

角 (0,0)，从左

到右，宽度依

次为 60，28，

28，28，28，28，

从上到下，宽

度依次为 50，

30，50。

按照上面

的宽度设置点

的坐标，就可

以 画 出 框 图

来。

1  画医院底层平面时，要用到 Mline（即 Multiline）命令（该命令在 Draw

快捷键中，将鼠标移到其上，会有该命令出现）。先要设置 Scale，将之设

置为 3，如下图所示。

2  设置好 Scale 后，就可以画底层平面图了，注意各点的坐标（坐标见左面

知识点），也可以用鼠标选取点的坐标。

3  在 Command 后键入 Mline 命令，先将 Scale 设置为 2，然后用鼠标选取点

的位置，画出窗口，即图中较窄的平行线。

画双线按钮

Multiline(画平行双线)
医院楼底层平面



        

在输入汉

字之前，一定

要设置文本参

数，这样输入

的 汉 字 才 正

确，否则会出

现问号。具体

的操作是按照

第四、第五步

中的菜单设置

参数，注意在

第五步的菜单

中 的 “ Font

name”项要选

择 “ T 楷 体

GB2312”，然

后点击第五步

菜 单 中 的

“Apply”键，

这时就可以用

Text 命令写入

汉字了。

具体操作

是在 Command

后键入 Text，

回车后，键入

J，再回车，键

入M，在 Angle

of text<0>:后回

车（如果键入

90，则字会旋

转 90度，因此

要回车），最后

输入汉字，得

到图形如左图

所示。

4  在输入文字时，先要设置文字格式，点击 Format 键，出现下面的菜单，

用鼠标点击菜单中的“Text style”键，可以设置各项参数。

5  点击“Text style”键后，出现下列菜单，在“Font name”项中，输入字体

名，并设置各项参数，然后点击“Apply”键。

6  设置好 Text style后，用 Text 命令可以写入汉字。在 Command后键入 Text

命令，输入 J，回车，键入 M，回车，用鼠标在作图区选取点，再设置字

高，再在<Text>后输入汉字，得到下面的图形。

7  总结：本例的重点在于如何设置参数，以便输入汉字，重点在第四、五步。

设置文本格

式



例 解例 解

             

               

  

Donut（圆

环）命令可画

实 心 圆 或 圆

环。这两种功

能的实现靠参

数 的 不 同 设

置。

对 实 心

圆 ， 其 参 数

Inside diameter:

设为 0，对圆

环则视情况而

定 。 注 意 在

Center of

doughnut:后需

要输入圆心位

置。具体操作

见 右 面 第 二

步。设置内径

和外径时，要

注 意 比 例 关

系，这样得到

的 图 形 才 美

观。在用到这

个命令时，要

注意变通，可

以将它与画圆

命 令 比 较 一

下。由所画的

实 例 可 以 看

出，当 Inside

diameter 及

Outside dia-

meter 设置不

同时，得到的

图 形 也 不 一

样。

1 在 Command:后键入 Donut 命令，Inside diameter 设为 0，Outside diameter

设为 80，Center of doughnut 设为（40，40），其图如下。

2  在 command后键入 donut 命令，将 inside diameter 设为 80，outside diameter

设为 100 时，画出圆环如下。

3  在上一圆环同一水平位置画另一圆环，在 Command:后键入 Donut 命令，

将 Inside diameter 设为 80，Outside diameter 设为 100 时，环心距离前者

环心 120，其图如下。

画圆环按

钮

Donut(圆环)
眼镜框



Donut 及

Trace 命令本

身并不难，与

Line 及 Circle

命令很相似，

只不过前者有

厚度而已。

本例也可

不涂黑圆环 ,

不 涂 黑 的 圆

环 ， 要 用 到

Setvar 命令。

Setvar 命令是

改变图形参数

的一个命令，

提 示 中 的

Variable name
指的是要输入

要 改 变 的 参

数 。 输 入 的

Fillmode 是一

个控制图形填

充 方 式 的 参

数，为 1 时有

效，为 0 时无

效。

用 Donut

命令画图很方

便，可以得到

读者想要的各

种圆环，而当

内外设置一样

时，就可以得

到圆。

  

4  用 Pline命令画镜架，在 Command命令下键入 Pline命令,设置Width 为 10，

然后按照下图的形式，用鼠标依次选点，其图如下：

5  在两圆环间画支撑架时，同样用 Pline 命令，这样，一个简单的眼镜框就

画成了。

6  不涂黑的圆环，要用到 Setvar命令。在 Command:后键入 Setvar，在 Variable

name or?:后键入 Fillmode，将 New value for fillmode<1>:设为 0。图形如下。

7  总结： Donut 命令是一个比较简单的命令。Donut 及 Pline 命令本身并不

难。



例 解例 解
Pline（画

多义线）命令

与 line 命令比

较 类 似 ， 但

Pline 可缩放，

而 Line 则不

能。

Pline 可以

画有一定宽度

的直线，这也

可以用 Trace

命令来画。对

于带有宽度的

各种符号，都

可 以 用 Pline

命令来绘制。

Pline 命令本身

并不难，与Line

命令很相似，

只不过前者有

厚度而已。

Pline 命令

实际上是画多

义线的命令，

本例只是介绍

改变线宽的功

能，还可以用

该命令连续画

出圆弧、直线

等线条。

在用 Pline

命令时，可以

用鼠标直接选

点，也可以输

入坐标，本例

是用前者的方

法。

1  用 Pline 画一有宽度的直线段。在 Command下键入 Pline,设置Width<0.050>

为 5。下面是用 Pline命令画直线段时的执行过程。

2  画一矩形，用 Pline 命令画矩形，表示扩音器，使线段的一端点在矩形一

边的中点，Half width 设置为 5。按照下图用鼠标在作图区上依次选点，

就可以画出下面的图形。

3  用 Pline 命令继续画图，以矩形的另一边为梯形的上底边，画等腰梯形，

即得扩音器的符号。用鼠标在作图区上依次选点，就可以画出下面的图形。

Pline(画多义线)
扩音器及电阻符号



half

用 Pline

画一矩形，在

画矩形时，注

意要连续输入

坐标，这样画

出的图形才是

矩形或者连续

的线条图形。

这一点与 R14

中没有什么不

同。

注意在画

矩形时，最后

不可用 c 来封

闭图形，用 c

来封闭图形是

用 Line 命令画

封闭线条图形

时所用到的快

捷命令。Pline

命令本身是很

容易掌握的命

令。

不涂黑电

阻时，要用到

Setvar 命令，

Setvar 命令是

一个设置系统

参数的常用命

令。

4  用 Pline 画一矩形，长为 150，宽为 50，Half width 为 2。用鼠标选取点，

画出的电阻图形见下面。

5  继续用 Pline命令在矩形两端画线段，注意对称，Half width 设为 2，即得

电阻符号。得到的电阻符号见下面图形。

6  如果不想使宽线涂黑，要用到 Setvar 命令。在 Command:后键入 Setvar。

在 Variable name or?:后键入 Fillmode,将 New value for fillmode<1>:设为 0，

得到的图形见下面。Setvar可使宽线不涂黑，其方法与 Donut相同。

7  总结：Pline 命令是一个比较简单的命令。Donut及 Pline 命令本身并不难，

与 Line 及 Circle很相似，只不过前者有厚度而已



返回总目录

，

本章导读

使用 AutoCAD2000 中的显示命令、图层、
线型及颜色命令可方便图形的修改，使图形
更易辨认，更清晰。在绘图及编辑中会遇到
这个问题：屏幕大小一定，而大图幅不能显
示全图。这就要用到显示功能。本章还将通
过实例介绍图层概念、图层命令、线型及线
型比例命令、颜色命令。使用图层，可便于
系统的管理图形参数，当要修改时，也可以
很方便地改变各个参数。图层中的各个命令
用于控制其参数，要熟练掌握。



例 解例 解
Zoom（缩

放）就象照相

机的“变焦镜

头”，能够放大

和缩小当前屏

幕窗口中图形

的视觉尺寸，

而实际尺寸不

变。放大可以

观察细节，缩

小可以显示较

大范围。

Zoom 菜

单是 View 中

的 Zoom，即

缩放菜单在视

区菜单之中，

缩放菜单中有

几 种 缩 放 方

式，即可变方

式、窗口方式、

全显示方式等

等。常用的就

是 这 几 种 方

式。当然，也

可以用输入坐

标方式给出要

显 示 的 区 域

来，非常方便。

对 于 本

例，采用的是

直接用鼠标操

作，即按住鼠

标左键，在作

图区上拉出一

个窗口，得到

区域。

1  Zoom菜单是 View中的 Zoom，用鼠标点击 View键，再点击 Zoom键，得

到菜单如下。

2  用 Rectang命令画一管道，长为 50，外径为 20，内径为 16。要用 Rectang

命令时，为了精确起见，要输入两个斜对角的坐标，其图如下。坐标为(0,0)，

(50,40)。

3  用 Layer 命令设一新的图层，线型设为中心线(Center)，改变图层，作一中

心线，如下图所示。

放大所选窗

口区域键 实时放大区

域按钮

Zoom(缩放)
管道纵截面



注 意 ，

Zoom（缩放）

命令只能从视

区 上 改 变 大

小，而不能改

变实际尺寸。

用 Zoom

中的 Windows

命令即窗口方

式，就可以使

选取的一个窗

口范围内的实

体进行放大,这

对于放大有限

区域内的实体

极为有用。

Hatch 命

令在前面已经

介绍过，在工

程绘图中是用

来 画 剖 面 线

的。可以用鼠

标点取要填充

区域的内部一

点，这样得到

的 图 形 见 左

面。改变角度

后的剖面线视

觉效果确实不

同。

4  用 Zoom 中的 Windows 命令，将图形放大，选取 Windows 方式，即窗口

方式后用鼠标在作图区上选取一个范围，得到的图形如下。

5  用 Hatch 命令画剖面线，以表示管道的剖面图，键入 Hatch 命令后，先选

择好剖面线的型号，然后用鼠标点取要填充区域的内部一点。回车后得到

的图形见下面。

6  当设置的剖面线的倾斜角度不同时，得到的图形也不同。例如，将剖面线

的倾角设为 60度，得到的结果见下图。

7  Zoom（缩放）命令只能从视区上改变大小，而不能改变实际尺寸。



例 解例 解

          

Layer 图

层是将需要的

线型、线条颜

色等图形的一

些基本性质设

置在一个图层

内，这里用作

辅助手段。用

Line 命令依次

画 出 大 致 轮

廓。

 设置线型

Center3 后画中

心线：（30，0）

到（30，65）

一条，平行该

中心线边界左

右各 5，即 25

和 35，高度从

3 到 53，画两

条直线。使用

Trim 功能，全

部选中，点击

要删除的线。

(可以最后一起

删除，这里无

法给出要删除

线的位置。用

户只能自己观

察)，用 Hatch

命令添加剖面

线。注意不同

的面必须使用

不同方向的剖

面线。

1  进入 Tools Drawing Aids使用 Ortho命令：保证正交作图方式。Snap on 命

令捕捉整数点。使用 Linetype 命令设置线型。如果没有中心线，进入

"Center2"，并且 Global scale factor 选 0.2.。

2  设螺纹大径 d=10，两板的厚度 d1=15;d2=15。使用 Line 命令和矩形命令

Rectangle 绘制基本轮廓。

3  用 Hatch 命令画剖面线，在 Command 后键入 Hatch 命令，设置参数，添

加剖面线。结果如图所示。注意不同物体使用不同的剖面线。

Layer(图层)
螺栓连接装配图



垫片的半

径 为 1.1d=

11 ， 高 0.2d

=2 ，画矩形：

(19，40)到(41，

42)。 螺 母 高

0.8d=8， 半径

为 10 ，画矩

形（20,42）到

（40，50）。

再将螺柱顶封

上。螺孔宽度

1.1d＝11。使

用 Line 命令，

画线点的坐标

为(24.5，10)到

(24.5 ， 40) ，

（ 35.5,10）到

(35.5，40)。画

圆弧，三点画

法中三点坐标

坐 标 分 别 为

(20,48.5) ，

(22.5,50) 和

(25, 48.5)。 使

用 mirror 命令

可 得 对 称 部

分 。 过 点

(25,48.5) ，

(30,50)和  (35,

48.5)得中心圆

弧 ， 倒 直 角

Chamfer 命令

中的  Distance

设 1。螺纹宽

8.5， 近 似 为

8,33。

4  画垫片，画螺母，封顶，完成螺栓的雏形。在这里，我们使用的所有参数

都是严格按照制图标准的。结果如下图所示。

5  绘制细节，螺钉基本由直线组成，只要用 Line 命令一步步完成就可以了。

螺母的几段圆弧可以使用 Arc命令的 three point(三点)方式，即给定圆弧通

过的三个点绘制圆弧，使用Mirror命令还可以减少工作量。

6  倒角，画螺纹。使用 Trim 命令修剪边角，删除不需要的线条，最后效果

见下图。

7  总结：为帮助用户熟悉绘图过程，本例给出了所有的绘图参数。用户可按

照右边的参数(或自己确定参数)完成本例。



例 解例 解
上例介绍

了 Layer命令

的方式，这页

介绍其对话框

的其它方式。

Layer 菜

单即图层菜单

的具体用法包

括好几种。

当用图层

菜单，即 layer

菜单设置好图

层时，包括图

层中的颜色设

置、线型设置、

是否冻结图层

等等命令。设

置颜色时，菜

单提供了几种

基本颜色，而

进入颜色设置

后又有几十中

颜 色 可 供 选

取。选取时，

只需用鼠标点

击要选取的颜

色即可，非常

方便。

右面菜单

框为设置好的

图层。

1  Layer 命令的对话框形式如下，从左到右依此为使实体为当前层、图层、

图层控制。

2  用对话框中的图层设置新的图层，即 Continuous及 Center。

3  将 Continuous图层中的线型设为 Continuous，颜色设为 Yellow，将 Center

图层中的线型设为 Center，颜色设为 Red。

设置图层按

钮

设置图层参数下

拉按钮

Layer(图层)
双孔垫片



用图层控

制可以方便地

设置当前层。

用图层控

制 可 以 将

Continuous 图

层 设 为 当 前

层，当然也可

以将其它的图

层设置为当前

层，这要视需

要而定，总之

要符合作图原

则。

同样可将

Center 图层设

为当前层，画

中心线。

Center 图

层中的线型设

置 的 是 中 心

线，所以要将

图 层 设 置 为

Center 层，画

出的图形见左

图。注意图层

设置的各项参

数，这对于以

后的绘图极为

方便。当然，

如果读者在绘

图之前已经设

置好各个图层

后，绘图会更

为方便。

4  用图层控制将 Continuous图层设为当前层，画双孔垫片。点击下图中的菜

单右上角按扭，出现下拉菜单，用鼠标点击要设为当前层的图层名称，就

可以将所选的图层设置为当前层。也可以用红色。

5  用 Rectang 命令，即画矩形命令画出垫片的外形，用 Circle 命令，即画圆

命令画出两个孔，所画的垫片如下。

6  同样点击第四步图中的菜单右上角按扭，出现第四步的下拉菜单。用鼠标

点击要设为当前层的图层名称，就可以将所选的图层设置为当前层。将

Center图层设为当前层，画中心线，其图如下。

7  用图层命令可以方便地设置读者想要的颜色和线型。



例 解例 解
Linetype

（线型）命令

可以装入线型

库中定义的线

型，为所画实

体设置不同图

层的线型，主

要用对话框方

式。

其对话框

方式与图层命

令相似。操作

时，用图层命

令设置线型，

也可用鼠标选

取。

具体操作

是点击图层中

的线型项，进

入线型设置，

出现很多的线

型，用鼠标选

取 所 要 的 线

型，在图层菜

单中点击已设

置好的线型，

就可以将所需

要的线型装入

设置的图层中

了。

用 Layer

命令时，可以

直接在 Com-

mand命令后键

入 Layer 命

令。

1  用 Layer命令设置三个图层，分别为 Continuous，Dash 及 Center。菜单形

式见下图。

2  Linetype 命令的对话框如下图所示。要装入线型，则点击鼠标所在位置就

可以装入了。

3  线型库对话框的状态如下。

 Linetype(线型)
管  道



在对话框

中的各种线型

包括虚线、点

划线、细实线、

粗实线、中心

线 和 圆 点 线

等。读者可以

根据需要选择

适合的线型，

可以通过对话

框中的选项选

取。

注意，为

了使绘图更有

效率，在画较

为复杂的图形

之前一定要先

设置好图层和

线型，这样会

起到事半功倍

的效果。

Center 图

层中的线型设

置 的 为 中 心

线，所以要将

图 层 设 置 为

Center 后 再

画。

4  在 Continuous图层中画管道外径，可以用画矩形命令即 Rectang命令画出

矩形，也可以用 Line 命令即画直线命令画，画出的图形见下面。

5  在 Dash图层中画管道内径，可以用图层菜单将 Dash 图层设置为当前图层，

然后用 Line命令，即画直线命令画管道内径，其图如下。

6  在 Center图层中画中心线，以用图层菜单将 Center图层设置为当前图层，

然后用 Line 命令，即画直线命令画中心线，图形如下。

7  这样画出的图形就为一个带有内母线的管道图形。



例 解例 解
Ltscale（线型

比例）功能是

调整线型中各

短划及其间隔

的长度。当短

划线在显示屏

上以连续线出

现时，应用该

命令调整短划

线 的 比 例 因

子。

在用图层

命令设置线型

时，也可以用

鼠标选取。

具体操作

是点击图层中

的线型项，进

入线型设置，

出现很多的线

型，用鼠标选

取 所 要 的 线

型，在图层菜

单中点击已设

置好的线型，

就可以将所需

要的线型装入

设 置 的 图 层

中。

图层控制

菜单将当前图

层设置为 Con-

tinuous 层时，

用鼠标单击第

三步图中右面

的 下 拉 键 即

可。

1  用 Layer 命令设置两个图层，一为 Continuous，一为 Dash。可以用 New

键设置。

2   用 Linetype 命令将两个图层的线型分别设为 Continuous及 Dash。

3  用图层控制菜单将当前图层设置为 Continuous层，其菜单如下图所示。

 Ltscale(线型比例)
门  框



在上面中

已经提到，可

以用线型命令

设 置 各 种 线

型。对于本例，

略 有 不 同 的

是，画出的线

不只是表示实

体，还可以表

示材料，这是

要 注 意 的 一

点。

左图中画

短划线表示玻

璃，这样画出

的玻璃更为逼

真，读者不妨

可以一试。

当然对于

木质的材料就

不能用这种方

法了。对于木

质的材料可以

用 斜 方 格 表

示。对于其他

材料可选择相

应 的 表 示 方

式。

对于铁质

的材料，可以

用斜线表示。

4  用 Line命令，或者用 Rectang命令画门的外框架，得到的图形见下图。本

例用鼠标直接在作图区选点。

5  用 Line命令，或者用 Rectang命令画玻璃的外框架，得到的图形见下图。

6  同第三步的方式，将当前菜单设置为 Dash 图层，然后用 Line 命令画出玻

璃上的短画线，得到一个完整的门框。

7  由操作及得到的结果可以看出，这样画出的图形为带有玻璃的门框。



例 解例 解
    本例用到

的 命 令 有

layer、 line 、

hatch 和 rec-

tangle 等。在

绘 图 的 过 程

中，首先要注

意 窗 口 的 设

置。为了便于

捕捉到需要的

点，窗口的大

小应当合适，

在能够装入所

有图形的前提

下，越大越好。

其次是基

准点的选择，

基准点应当是

某个有利于迅

速确定其它位

置点的坐标的

点，可以是中

心点，也可以

是某一角上的

点等等。本例

将基准点选择

为阀杆中心，

这个基准点是

一系列的圆的

圆心，在确定

了上面中心线

的位置以后，

整个图形的框

架就已经建立

起来了。

1  在 Command 后键入 Layer 命令，进入设置图层菜单。用“New”键

建立新的图层。将线型设置为 Center2。如果在线型列表中没有这种线型，

按照介绍过的 LineType 命令装入线型。按照下列提示设置窗口。

3  完成阀体轮廓。首先按照其轮廓画一系列的矩形，然后使用 Trim 命令修

剪。希望大家能够熟练掌握 Trim 的用法。参数的选择可以灵活。

2   画阀盖轮廓。将阀杆中心设置为（55，30），作同心圆。半径分别为 R4，

R7，R10，R20。因为在阀体上有三个螺钉孔，所以进入图层 1，用中心

线绘制一半径 15的圆。这时绘制图形如下图。

综合实例
蝴蝶阀剖面图



显然主要

点的位置应当

是整数点，以

便使用 Draw-

ing aids 中的

Snap 命令方便

地捕捉到整数

点。这有利于

用鼠标在途中

直接捕捉到需

要的点，而不

必用键盘输入

点的坐标。

有时图中

要出现不是整

数点的坐标，

例如直线和斜

线的交点，呈

中心对称分布

的图形（例如

本例中的三个

螺钉）。这时我

们应当尽量根

据 图 形 的 特

征，使用目标

捕 捉 方 式 或

Array ， Move

等命令，避免

直接输入点的

坐标。

粗细线的

设置可以在完

成图形绘制后

统一进行。

4  画三个螺钉。首先画第一个。定位中心在(55,15)，半径取 2.。按照螺钉的

画法完成螺纹剖面图。因为另外两个螺钉的位置不在整数点上，很难确定

圆心坐标，故使用 Array命令来完成。Array提示的参数设置如下。

5  用 Hatch 对话框方式设置添加剖面线。注意在阀体上中还有阀杆和齿轮，

所以应该使用不同的抛面线。剖面线使用 ANSI31，用户可以通过设置不

同的比例 Scale 和角度Angle 来区分这些剖面线。

6  阀体底座上还有一些轮廓需要补全。由于所画的只是一个视图，用户可能

不清楚其中一些轮廓线代表什么，请不必在意。我们使用 Line 命令。根

据零件图的要求，还要处理一些倒角。最后效果如下图所示。

7  总结：蝴蝶阀是一个典型的机械零件，用户可以在几乎所有的机械制图教

材中找到其零件图和参数。用户要特别注意本例中的绘图顺序。



例 解例 解

           

 

轴的主体

是 一 段 阶 梯

轴，绘图一定

一定要从简单

到复杂，先作

出大致轮廓，

再完成细节。

我们可以设想

是在按照零件

的实际加工过

程绘图。

绘图过程

虽然要求尽量

选择简便的方

法，但是一定

要按照基本的

绘 图 要 求 来

画。例如本例

中绘制螺纹底

部时，如果严

格按照 0.85×

螺纹大径的要

求，是不能近

似为 6 的。这

里只是一种近

似。

步骤 3 中

绘制齿条时使

用 了 简 化 画

法。由于圆柱

的一部分被切

掉了，所以视

图要有一定的

缩进。请读者

对照本图和下

图，观察两者

之间的差别。

1  用 Line 命令及 Rectangle命令完成齿杆的大致轮廓，包括主要的阶梯轴，

其中直径 20 段的长度为 70，直径 14 的一段的长度为 34。绝对坐标用户

可以自己确定，如下图所示：

2  在轴的右边有一段螺纹，因为轴的直径是 14，即螺纹大径，所以需要添

加距中心线 7×0.85＝6 的虚线。设螺纹长度为 15。按照螺纹的画法画出

倒角，如下图所示。

3  蝴蝶阀传动的主要部件就是齿杆上的齿条。我们在阀体 (见上例)上已经画

出了齿轮，所以我们在齿杆上画出齿条。画法是，首先画直线，然后使用

三点方式画圆弧，如下图所示。

综合实例
蝴蝶阀齿杆剖面图及连接



本例的一

个重点部分是

将齿杆作为一

个块插入到蝴

蝶阀阀体中。

用户将发现使

用 Block 命令

是 非 常 重 要

的。

插入过程

中系统将要求

用户输入插入

的位置、放大

比例、旋转角

度等参数，用

户可在前面的

相关章节中找

到关于 Block

命令的具体参

数 的 设 置 方

法。注意，在

插入的过程仅

仅是两个图的

简单叠加，而

由此产生的一

些轮廓线的覆

盖需要用户用

Trim 命令来重

新编辑。

4  蝴蝶阀齿杆用销钉和阀体连接。在上例中我们已经在阀体上画出了销钉

孔。我们在这里画出键槽。画图时使用的是局部剖面，所以用多义线命令

Pline画出剖面边界。使用 Hatch命令添加剖面线，图形如下。

5  这样我们完成了齿杆的绘制。下面要做的就是将其插入上例绘制的蝴蝶阀

阀体中。首先将整个齿杆定义为一个块，下面的命令行将告诉您如何定义

这个块。设块名(Block name)为 lux。

6  在定义块的过程中，系统要询问 Innsertion base point，即插入基点。这里

设置为齿杆左上方的点。下面我们将块 lux插入阀体。因为二者是配合的，

所以插入点要选择一个合适的位置。同时要处理一些相贯线的细节。

7  总结：我们完成了一个完整的蝴蝶阀结构的绘制(虽然只是一个视图)。在

掌握了基本命令以后，经过一定的实践，用户很快能够掌握绘制零件图的

要领。



例 解例 解
画建筑图

形外观图时，

主要是用到了

Line 命 令 及

Rectang 命令。

画外观时，按

照图形中的标

注，先画最顶

层的顶部，坐

标是 (0， 100)

和(100，95)，

然后画主体部

分，中间七根

竖线的坐标依

次是 (10,95)和

(10,6)，(14,95)

和 (14,15) ，

(29,95) 和 (29,

15)，(44,95)和

(44,15)，(59,95)

和 (59,15) ，

(74,95) 和 (74,

15)，(89,95)和

(89,15)。对于

七根横线，坐

标为(10, 90)和

(90,90) ， (10,

75)和(90, 75)，

(10,60) 和 (90,

60)，(10, 45)和

(130,45)， (10,

30) 和 (130,

30)，(10,15)和

(130,15)，(10,0)

和(130,0)。

1  在建筑设计时，经常要画房子的外观。下面是用 Line 命令画出其框架，

各点坐标见下图所示。

2  在用 Line 命令画出框架图形，按照左面的坐标参数输入各点的坐标，最

后得到的框架图形见下图。

3  画好外框架后，用 Rectang 命令画石阶。注意，输入的坐标是矩形两角的

坐标，依次为 (89,8)和(109,6)、(85,6)和(113,4)、(81,4)和(117,2)、(77,2)和

(121,0)。对于左面的石阶，可以用鼠标直接选取点。

综合实例
公  寓



画窗时，

用到了 Rectang

命令，这里要

注意的是窗口

各点的坐标，

可以先在左上

角画一个窗，

然后用复制的

方法将之复制

到 其 他 的 窗

口。

本例采用

块 操 作 的 方

法，先画窗口，

可以用 Rectang

命令，依次输

入下列坐标（注

意都是矩形的

两角坐标）：

(15,89) 和 (28,

76)， (15,89)和

(21,76)，(18,89)

和 (25, 76) ，

(15,89) 和 (28,

85)。 然 后 用

Block 命令定

义成块，块名

是“chu-ang”，

基 点 坐 标 是

(15,76)。最后

用 Insert 命令

将之插入到图

形中去，可以

用 鼠 标 选 取

点。

4  为了画公寓楼的窗，先用 Rectang 命令在作图区中画出一个比例适合的窗

来，可以用鼠标直接选取点，然后用 Block命令将之制成块，以供后面插

入时用。菜单状态见下图，基点选左下角。

在插入块时，在 Command后键入 Insert 命令，输入块名。

6  可以用同样的方式，在作图区上画出一个门，可以直接用 Rectang 命令在

门 的位置处画出门，最后得到的图形见下图，注意，门的参数参见右面

的知识点。

7  总结：用简单的 Line 命令及 Rectang 命令可以画出如上图所示的外

观图形。



返回总目录

本章导读

AutoCAD 中形、块与图案填充的命令不
多，但丰富多彩，本章将 Text命令归于“形”，
只是为了方便。有 Text 命令，就可以给图纸
进行文字说明，置于图中的字符会与图形文
件一起保存。对于字符或一些特殊符号，可
以用“形”的方式来描述，便于插入调用。
块是一组实体的组合，调用时改变一些参数，
可得到不同大小、不同方向的块图形。图案
填充是指将图案填充到指定的封闭区域，图
案是以块的形式填充的。学习了本章，可以
自己做一些图形块，保存在系统中，以备今
后进行二次开发，其实很多二次开发的东西
都是用这种方式，它并不难，只是需要有耐
心。



例 解例 解
Text （ 注

写字符）可以

在图中注写字

符，便于对图

形进行说明。

可以选择字符

串 的 排 列 方

式、字高及基

线角度。

Text 命令

经常用在一些

图 形 注 释 之

中，例如，在

要对某张图纸

作公差说明，

或者是填写制

图人、制图单

位等情况。

用这个命

令时，要注意

它 有 几 种 方

式，可以对提

示中的各种参

数方式进行选

择。选择 J 和

M 表示以所选

点为输入文字

的中心，当然

还可以输入其

它的方式。在

ACAD2000 中

较常用的是这

种方式。

1  Pline命令在 Draw菜单中，先用 Pline命令画一多义线，在 Command:后键

入 Pedit 命令，用 Fit 方式画出心的一半，用 Pline 命令及 Pedit 命令画心

的另一半。

2  在画出心的一半后，要用 Mirror 命令画出心的另一半。在 Command:后键

入 Mirror 命令，再用鼠标选择实体及对称轴，用 Mirror 命令将其镜像，

得到心的图案。

3  在画完心的标志后，要用 Text命令写字符，在 Command:后键入 Text命令，

在 Justify/Style/<Start point>后键入 J，执行过程如下。

Text(注写字符)
心  脏



4  按第一、第二、第三步操作后，得到带有 heart 字符标志的心的图形，进

行操作后得到的图形如下。

5  在 用 Text 命令时若不用 Fit 方式，而用其它方式，例如用

Align/Fit/Center/Middle/Right:中的Middle 方式，得到的图形如下图所示。

6  上图中的心脏上有多出来的线，用 Trim 命令将多余部分删去，最后得到

的心脏见下图所示。

7  总结：只要熟练掌握这些基本命令，画出心的标志并不难。

Text （ 注

写字符）还可

以在图中注写

汉字。读者可

以想一想，在

输入制图者姓

名、单位等信

息时，要用到

汉字。这里暂

不介绍，在后

面有相应的介

绍，读者可以

看一看。

由结果可

以看出，只要

熟练掌握这些

基本命令，可

以轻松地画出

“心”的标志。

在写 heart 字符

时，对 Text 命

令还可以用其

它几种方式。

Trim 命令

是  一  个  编

辑 命 令， 在

ACAD2000 中

该  命  令  的

快 捷 键形 方

式  更  为  友

好， 这 与 R14

相 比有 了 较

大 的 进 步。

    

        



例 解例 解
Dtext（动

态写字）功能

与 Text 命令完

全相同，只不

过在提示区输

入时，屏幕上

会临时显示字

符，便于随时

反馈。

该命令与

Text 命令没有

大的区别。 可

以  将  两  个

命  令  比  较

一 下。用 Text

命 令 写 字 符

时，选用 Justify

方式，则键入

J，然后可以选

用 Middle 方

式。 而用Dtext

命令时，选用

Justify 方式，

再用 Fit 方式，

用鼠标在作图

区中选取始终

点。设定字高

后，可以输入

要写的字符。

这样可以

见到所要输入

的字符在图形

中的显示。

1  Spline 命令在 Draw 菜单之中，可以用 Spline 命令先画出苹果的一半，回

两次车后再画另一半，然后画柄。用 Spline 命令在作图区画苹果，如下图

所示。

2  本例介绍动态写入文字，要用到 Dtext命令，按下列提示输入，在 Command:

后键入 Dtext命令，执行过程如下。

3  按照第二步的提示输入后得到的图形字符是动态的，在屏幕上得到的图形

如下。

Dtext(动态写字)
苹果(一)



如果读者

在输入字符时

要随时了解输

入的情况，可

以用动态写字

Dtext（动态写

字）命令，便

于随时反馈。

它有好几种方

式。

 在 这 一

点上，ACAD-

2000 与 R14

相比，没有多

大改变，熟悉

R14 的用户可

以轻松学会这

个命令。

用鼠标在

作图区中选取

中点。设定字

高后，可以输

入 要 写 的 字

符。

本例输入

的 单 词 是

apple，表示所

画的图形是苹

果。当然读者

可以根据需要

输入不同的字

符，从而得到

满意的效果。

4  第三步得到的图形是动态输入字符过程中等一部分，输入一行字符后，还

可再输入一行字符。具体操作是：在键入一行字符后，回车，可继续键入

另一行字符。

5  如果要退出 Text 命令，则在 Text:后连续两个回车，就结束 Dtext 命令，屏

幕上会以指定的方式显示字符。

6  下面用 Trim 命令对上图中的苹果进行修饰，将多余的线删除，用 Change

命令将画的苹果改为红色，得到的图形见下图。

7  总结：只要熟练掌握这些基本命令，画这个苹果并不难，要熟练掌握 Dtext

命令。



例 解例 解
Style （设

置字样）用于

设置或修改字

样，用对话框

方 式 操 作 。

Qtext命令在图

形重新生成时

控制是否显示

字符。On时不

显示字符，但

会 出 现 矩 形

框，Off 时则

会出现所画的

字符。

本例是将

Style 命 令 与

Dtext 命令结

合使用，可以

用 Style 命令

设置好字符的

大小、高度和

字形。在ACAD

2000 中，各个

界面都非常友

好，这对于初

学 者 尤 为 方

便。

界面更为

友 好 ， 这 是

ACAD2000 的

一个特点。

1  在 Command后键入 Style 命令，得到 Style 命令菜单形式如下，并设置字

样格式。

2  Spline命令在 Draw菜单之中，用 Spline命令画一苹果，并用 Text中的 Style

写入字符，画出的图形见下面。

3  Qtext 命令用于控制在图形重新生成时是否显示字符。用 Qtext 命令控制参

数，使重新生成图形时不显示字符，执行过程如下。

Style(设置字样)
苹果(二)



从 Style

（设置字样）

对话框中的内

容可见，设置

或修改字样的

方 式 有 很 多

种，用户可根

据需要来定。

Qtext命令（控

制）是在图形

重新生成时控

制是否显示字

符， 与 Regen

命 令 联 合 使

用，On时不显

示，但会出现

矩形框。由此

可见，要熟练

掌握这些基本

命令，一定要

知道各个命令

的控制关系。

只有知道了各

种控制关系，

操作起来才很

方便。例如，

Qtext命令是用

来控制字符显

示的命令。

4  Regen 命令是用来重新生成图形。当改变系统变量后，要重新生成图形。

可以在 Command:后键入 Regen命令，用 Regen命令重新生成图形，如下

图所示。

5  画完苹果后，可以用 Trim 命令将上图中多余的线删除，并且用 Spline 命

令画出一个缺口，表示被虫子咬坏了，如下图所示。

6  最后用 Change 命令将所画苹果的颜色改为红色，得到下面的图形，是一

个被虫子咬坏的苹果。

7  总结：要熟练掌握这些基本命令，同时也要知道各个命令的控制关系。例

如，Qtext命令是用来控制字符显示的命令。



例 解例 解

 

工作内容 定义形文件 编译文件 装入文件 调用形

   工具 文本编辑程序 命令 命令 命令

   结果 得到形的原文件 得到形的目标文件 形可被调用 绘制形

   *形编号，描述该行所用字节数，形名称

   *：标题行的专用标记。

   形编号：范围为 0—9，11—31，130—255。

   字节数：描述行的总字节数。

   形名称：可由大写字母和数字组成。

 000——形定义结束

 001——落笔

 002——抬笔

 003——用下一字节去除其后所有矢量

 004——用下一字节去乘其后所有字节

字符实际

上是一种形文

件，学了本例

后，就可以自

己 定 义 形 文

件，例如名字

等。本例只介

绍形的一些基

本知识。

在用专用

码编写形文件

时，一定要注

意什么时候用

空格键，什么

时候不用空格

键，即空格键

要用得合适，

否则生成的形

文件不对，就

不会生成读者

所 要 得 到 的

形。

其实，这

一部分的内容

并不难，只要

有耐心，还要

仔细，可以做

出读者所要的

字库。

当然，各

个符号所要表

示的意义一定

要记清楚，这

样在以后的应

用中才可以运

用自如。

1  对于字符或一些特殊符号，可以用“形”的方式来描述，便于插入调用。

“形”从定义到调用的过程可用下表表示。

2  每个形可定义多个形，每个形的定义包括一个标题行和若干个描述行。标

题行格式如下：

3  本例介绍一些基本的专用码，这些专用码经常用到。在后面的例子中会用

到，不清楚的可以查阅下面的专用码。

Shape(形)
字符(一)



学了本例

后，用户就可

以自己定义形

文件。

可以用专

用码编写形文

件，这些专用

码在前面已经

介绍过，用户

要注意各种专

用码的区别，

不要弄错。

在每个专

用码之间要有

空格。如果用

回车键，则相

当于空格键。

用 Com-

pile 命令编辑

时，要注意形

文件的存储位

置。这样在选

取文件时，才

能 迅 速 找 到

它，否则，要

用查找命令。

这样用起来就

较为繁琐，不

利于绘图。

4  矢量描述有几种方式，本例只介绍标准矢量，如下图所示，用 0—9 及 A

—F表示 16个方向。

5  在 Command:后键入 Compile 命令，出现如下对话框，选择形的源文件名

填入。

6  用 Load命令装入形文件，用 Shape 可以调用形。

7  总结：本例主要介绍形文件的一些基本概念和生成行文件的步骤，以及怎

样调用形文件。



例 解例 解
学了形的

定义，本例将

作 一 形 的 实

例，造字库。

中间数字的第

二位为步数。

第一行中

的 131 表示形

编号为 131，

当然也可以是

其它的编号。34

表示描述该形

所用字节数为

34，DIAN2 表

示形的名称。

第二行中， 3

表示用下一字

节去除其后所

有矢量，即用

11 去除其后所

有矢量， 2 表

示抬笔， 034

表示从原点开

始以矢量 3 的

方向在 X 轴分

量 上 走 了 4

格，1 表示落

笔，其它可以

类推，最后的

0 表示形定义

结束。

本例主要

是用上一页的

代码编写一个

形文件，从而

1  要编写形的源文件，需要在记事本中编写，并用前面的专用码编写。在记

事本中用专用码写出形的源文件如下，命名为 dian。

2  在 AutoCAD中，用 Compile命令进行编辑，生成形的文件。键入 Compile

命令后，得到以下菜单。选取形文件 dian。

3  用 Load 命令装入形的目标文件，其对话框如下。用鼠标选取文件

“dian.shx”，单击“打开”键。

Shape(形)
字符(二)



得到一个形，

该 形 是 一 个

“电” 字。

用 Com-

pile 命令编辑

时，系统反馈

编译的信息，

读者可以根据

反馈信息决定

下一步操作。

学会了造

字符，就可用

这些方法制作

自己的字库，

在制作好后，

可以保存在硬

盘里，在以后

的图形中可以

插入，以装饰

图形。

当然，还

可以用形文件

编写其它的汉

字，读者可用

这种方法构造

一些简单的汉

字。

在编写形

文件时，要注

意 文 件 的 内

容，一不小心

就会弄错。

4  在按第一、第三、第三步操作完后，就生成了一个形文件。用 Compile 命

令编辑时，系统会告诉已编译成功，可以调用了，用 Shape 命令调用一个

形，执行过程如下。

5  用 Shape 命令调用不过生成的 dian2形，最后生成的字如下图所示。

6  除了可以写出“电”字以外，还可以写自己的名字，例如，写一个“伟”

字，得到的字符如下图所示。

7  总结：用形的命令生成字符是生成字库的一种方式。想不想做自己的名字？



例 解例 解
用形定义

不仅可以造字

库，还可定义

一 些 专 用 符

号，如电阻。

其定义方式与

生成字符的定

义方式一样。

文件中第

一行中，12 表

示形的编号为

12，14 表示描

述形所用的字

节数。第二行

中 DIAN-ZHU

表 示 形 的 名

称。第二行中，

2 表示抬笔，

054 表示从原

点出发沿矢量

4 方 向 走 五

格，其它类推。

可 以 说

AutoCAD 中的

符号也可以用

形 文 件 来 定

义，得到形图

形后，可以保

存在硬盘中，

供以后调用。

对于这个

功能，本例将

介绍编写电阻

符号，并将之

存在硬盘中，

供以后调用。

1  要编写形的源文件需要在记事本中编写，并用前面的专用码编写。在记事

本中用专用码写出电阻的源代码，文件命名为 dianzhu。

2  在 AutoCAD 中用 Compile 命令编辑源文件，键入 Compile 命令后，得到

的对话框如下。选取“dianzhu”文件，然后单击“打开”键。

3  用 Load命令装入形文件。

Shape(形)
电阻符号



从第四步

中提示信息，

读者可以根据

反馈信息决定

下 一 步 的 操

作，系统要求

输入形名，即

Shape name

(or ?) Height

<1.0000>是要

求输入形的高

度 。 Rotation

angle <0>要求

输入形的旋转

角度。

造字符，

就是用这些方

法制作自己的

符号库，制作

方法与本例相

同，只是在制

作好后，可将

字符形文件保

存在硬盘里，

在以后的图形

中可以插入，

以装饰图形。

注意，第

六步中的“文

件名”项后输

入 形 文 件 名

Drawing.dwg。

4  当用 Compile 命令后，系统会告诉已经编译成功，而用 Load 命令后，系

统会告诉装载成功。这时可以用 Shape命令调用形文件，执行过程如下。

5  当用 Compile命令、Load命令、Shape命令操作后，可以得到电阻的符号，

最后生成的图形如下。

6  最后将所画的电阻图形保存在硬盘之中。

7  总结：用形的命令来生成字符是生成字库的一种方式。当然还可以用这个

命令制作一系列字符作为字库。



例 解例 解
Block（块）

可以将一组图

形定义成块，

该命令定义的

块 暂 存 于 内

存，供当前插

入使用，当前

图存盘时，随

图形文件一起

存储，在别的

文件中不能引

用。

画电感符

号时用到 Pline

命令，用它可

以 画 出 粗 线

条，只需要设

置线宽就可以

了。

用 Pline

命 令 画 粗 线

时，一定要先

设置宽度，这

样才可以开始

画线段，并最

终得到有宽度

的线条。

注意，可

以用鼠标直接

在作图区上选

取 各 点 的 位

置，也可以输

入坐标。本例

用 第 一 种 方

法，得到的图

形 如 右 图 所

示。

1  为了便于画用 Pline命令画电感，需要用 Grid命令设置栅格。在 Command:

后键入 Grid 命令，将其设置为 On状态，得到图形如下。

2  画电感符号时用 Pline 命令画粗线条。用 Pline 命令画电感符号，执行过程

如下，用鼠标点击要选点的位置。

3  用 Pline 命令画出粗线条，用图形上的格点画端点，就得到一电感的符号，

画出后的图形如下。

Block(块)
电感(一)



          

Block（块）

命 令 主 要 与

Insert 命令联

系起来用，用

该命令定义的

块 ， 可 以 用

Insert 命令插

入，也可以用

Measure插入。

   Block（块）

将一组图形定

义成块后，将

块 暂 存 于 内

存，供当前插

入使用。

由结果可

以看出，为了

便于以后调用

所作图形，可

以用 Block 命

令 将 之 存 为

块，这也可以

与 AutoCAD

的二次开发联

系起来，在以

后的应用中调

用这个块。将

图 形 存 为 块

后，只能在当

前的图形文件

中调用，这是

要 注 意 的 一

点。

4  Block 命令可以将所画的图形定义为块，用 Block 命令可以将所画的图形

定义为块，同时作图区上的图形消失。

5  为了插入所画的块，可以用 Insert命令，单击 Insert 键，出现下列菜单。

6  调用块时，用 Insert 命令时。也可以在 Command后键入 Insert 命令，用鼠

标选取要插入的点，得到的图形如下。

7  总结：为了便于以后调用所作图形，可以用 Block命令将之存为块。



例 解例 解
   Wblock（将

块存盘）是将

定义过的块存

盘，形成文件，

或者在存盘时

同时定义块。

本例仅介绍后

一种。

Wblock 与

Block 命令有

一点不同。

Block（块）

也可以将一组

图 形 定 义 成

块，该命令定

义的块暂存于

内存，供当前

插入使用，当

前图存盘时，

随图形文件一

起存储，在别

的文件中不能

引用。在用到

所 存 的 文 件

时，只能用.dwg

形式，而不能

用块的形式，

这一点是要注

意的。当然在

同一图形文件

中可以调用存

的块文件。

1  画电感符号时用到 Pline命令，用它可以画出粗线条。Half width选用缺省

值，用鼠标直接选取点的位置。用 Pline命令画如下图所示的电感图。

2  Wblock（块存盘）是将定义过的块存盘，形成文件定义块。在 Command:

后键入Wblock命令，会出现下面的对话框。在框中填入文件名。

3  Wblock（将块存盘）是将定义过的块存盘，形成文件，或者在存盘时同时

定义块。提示输入时，在 Block name:后直接回车，则作选择集，写文件

时同时定义块，执行状态如下。

Wblock(将块存盘)
电感(二)



用 Wblock

（块存盘）命

令将定义过的

块存盘，同时

会形成文件，

或者在存盘时

同时定义块。

以 后 可 以 用

Open 命令调用

出来。

最后得到

的图形为一个

电感符号的图

形。在画电路

图时，可以将

这个图形插入

到电路图中。

用块操作

可以将已画的

经常要用到的

图 形 保 存 起

来，已备需要，

在必要时，可

以用 Scale 命

令将之缩放，

从而得到所需

的图形。当然

保存的文件应

为“ .dwg”形

式，这是要注

意的一点。

4  按照提示输入时，在 Block name:后用“*”响应时，可将整个屏幕定义为

块，同时将文件写入磁盘。用 Insert命令可以插入所定义的块，如图所示,

也可以同上例一样用菜单方式，但不便于使用 Object snap。

5  当用Wblock 命令将所画图形存盘后，以后可以用 Open命令打开存盘的文

件，如下图所示，选取要打开的文件，然后单击“打开”键。

6  最后得到的图形为一个电感符号的图形，如下图所示。在画电路图时，可

以将这个图形插入到电路图中。

7  总结：为了便于以后调用所作图形，可以用 Wblock 命令将之存为块。以

后又可以用 Open命令调用出来。
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Insert（插

入块）命令可

以调用块到当

前图中，用该

命 令 插 入 块

时，输入的块

名如果找不到

该块定义，则

寻 找 同 名 的

DWG 文件。

如果有同名文

件，则将其作

为块插入到当

前图中。

Insert 命

令经常与Block

命 令 联 合 使

用，具体使用

方法是先用一

些基本的命令

画出所要得到

的图形，再用

Block 命令将

其定义成块，

以便在需要时

调用，这时用

Insert 命令就

可以了。

用 Insert

命令时，要输

入块名、插入

点的坐标、缩

放因子及旋转

角 度 。 这 与

Copy 命令很相

似。

1  画电感符号时用到 Pline 命令，用它可以画出粗线条。Pline width 使用其

缺省值，用 Pline 命令画一电阻符号，用鼠标直接选取点的位置，电阻图

形如下。

2  用 Pline 命令画出电阻符号后，可以用 Block命令将之定义成块。用 Block

命令将所画图形做成块时，在 Command 后键入 Block 命令，然后用鼠标

选择实体，并输入块名。图形状态如下。

3  用 Block 命令将电阻符号定义成块后，要调用块需要用到 Insert 命令。在

用 Insert 命令插入所作的块时，其菜单显示如下。

Insert(插入块)
电阻电路



为了便于

将绘图文件作

为块插入到图

中，建议绘图

时用 Base命令

确定一合适的

基点。

在调用块

时，要输入基

点，这时要输

入坐标，然后

输入要插入的

坐标，要计算

好，这样才不

会 出 错 。 用

Trace命令画电

路图形，在需

要画电路电阻

的地方用 Insert

命令将所画的

电阻符号插入

到电路图中。

为了便于

以后调用所作

图形，可以用

Block 命令将

之存为块，而

后用 Insert 命

令插入块。

注意，图

中的小圆环是

用 Donut 命令

画出的。

4  插入的图形如下。注意前一页在 Command后用 Insert 命令，输入块名时，

块名前有一“*”，表示该块图形被自动释放。

5  因为用“*”符号释放了块，则可用 Erase 命令删去图中一部分。如块未被

释放，则整个块会被删去。

6  用 Pline 命令画电路图形，在需要画电路电阻的地方用 Insert命令将所画的

电阻符号插入到电路图中，得到的电阻电路如下图所示。

7  总结：为了便于以后调用所作图形，可以用 Block命令将之存为块，而后

用 Insert 命令插入块。
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Minsert
（块阵列）可

以以矩形阵列

方式一次插入

多个块到当前

图中，相当于

Insert 命令与

Array 命令的

综合。

Minsert

（块插入）与

Insert 命令的

区别在于，在

插入块时可以

同时将块进行

阵列，而 Insert

命令只是进行

块插入。

用 Minsert

命令进行操作

时，也要输入

插入点，可以

用鼠标选取，

也 可 以 在

Insertion point

X scale factor

<1>/Cornor/XY

Z:Y scale factor

(default=x): 后

输入坐标，再

依 次 输 入 转

角、行数、列

数、行距、列

距。总之，不

要将顺序弄错

了。

1  Ellipse 命令在 Draw 菜单之中，Array 命令在 Modify菜单之中。用 Ellipse

命令及 Array命令画一花朵，可以先用 Ellipse画一椭圆，再用 Array命令

阵列，如下图所示。

2  可以用 Block 命令将之定义成块，用 Block命令将所画图形做成块时，在

Command:后输入命令，然后用鼠标选取实体，如下图所示。

3  用 Block 命令将电阻符号定义成块后，要调用块需要用到 Minsert 命令。

用Minsert 命令调用块，执行过程如下。

Minsert(块阵列)
花布图案



注意，用

Minsert 命令将

块阵列，比用

Array 命令的

矩形阵列更节

省空间，特别

适用于印制电

路板上大量元

件的排列。

对于读者

来说，在绘图

过程中一般用

到的是 Insert

命令，而不是

Minsert 命令，

因此读者对后

者的用法不太

熟悉。但是，

Minsert 命令确

实是极为有用

的一个命令，

尤其在重复插

入块时更显其

优势。这样就

可 以 省 去 用

Array 命令阵

列的麻烦，得

到的图形见左

图。当然还可

以做得更漂亮

一些。

4  用Minsert命令操作时，可以连续操作，按上一步操作得到的图形如下。

5  继续用 Minsert 命令将画出的花朵块进行阵列操作，同时输入缩放因子，

得到带有花蕊的图案，如下图所示。

6  为了表示花朵的分界，可以用 Line 命令在花布图案中画出分界线，直接用

鼠标在作图区上操作，这样得到的图形更为美观。

7  总结：为了便于以后调用所作图形，可以用 Block命令将之存为块，而后

用Minsert命令插入块。
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Hatch（图

案填充）命令

可以将图案文

件中提供的图

案填充到封闭

区域内，并可

临时定义简单

图形填充到封

闭区域。先介

绍 Command:

命令下方式。

画剖面线

要用 Hatch 命

令。这个命令

在机械制图中

是常用命令，

对于工程技术

人 员 尤 为 重

要，读者要熟

练掌握。设置

参数时，可以

用缺省值。然

后选取比例因

子，并且输入

角度，最后用

鼠标选取要填

充的实体。用

鼠标选取要填

充的实体，可

以整个选取（如

右图），也可以

在实体中选取

一点，得到的

效 果 是 一 样

的。

1  Rectang命令在 Draw菜单之中。为了用 Hatch 命令，可以先用 Rectang 命

令画一矩形。用 Rectang 命令在作图区画一矩形，可以用鼠标直接在作图

区上选取两个对角点的位置，如下图所示。

2  为了画出剖面线，要用到 Hatch 命令。在 Command:后键入 Hatch 命令，

回车后，按下列提示，自己定义剖面线进行图案填充。

3  在用 Hatch命令画剖面线时，要作选择集，按照输入提示用鼠标作选择集，

图形如下。

Hatch(图案填充)
花格布



Hatch（图

案填充）命令

经常用在工程

绘图中，主要

是用该命令来

绘制剖面线。

画花布图

案时，为了使

图案可以变得

更为美观，可

以用 Colors 将

图层设置为红

色，或者设置

为蓝色。设置

Colors 时比较

简 单 直 接 在

Command 后输

入 该 命 令 即

可。

用 Copy

命令将画得的

图形组合到一

块，就得到一

张美观大方的

红蓝相间的花

布图案。

当然，为

了得到其它颜

色 的 花 布 图

案，可以用图

层命令将颜色

设置为其它颜

色。

4  按照提示输入参数，用鼠标选择实体后，则回车或按鼠标右键，得到图形

如下。

5  为了使图形更为美观，可以用 Change 命令将图形的颜色改为红色，红色

代号为 1，得到的红布图形见下图。

6  如果要得到其它的颜色，也可以用 Change 命令将布的颜色改为蓝色，可

以将红蓝布组合得到花布图案，图形见下图。

7  总结：要画剖面线，要用到 Hatch命令，用 Command方式比较方便。



例 解例 解
Hatch（图

案填充）命令

有 自 定 义 方

式，在选取实

体不同时，其

效果也不同。

Hatch 命

令可以将图案

文件中提供的

图案填充到封

闭区域内，并

可临时定义简

单图形填充到

封闭区域。

实际上，

用 Hatch 命令

作剖面线时，

假如我们要在

剖 面 线 中 写

字，而同时又

不希望字被剖

面线所覆盖，

这时应该怎么

办？这就涉及

到填充剖面线

的方式问题，

填充剖面线有

两种方式，读

者可以详细看

看，从而对该

命令有一个大

致的认识。

1  Rectang命令在 Draw菜单之中。为了用 Hatch 命令，可以先用 Rectang 命

令画一矩形，再用 Text 命令写字符，如下图所示。

2  为了画出剖面线，要用到 Hatch 命令。在 Command:后键入 Hatch 命令，

回车后，按下列提示，用 Hatch命令进行剖面线填充。

3  在用 Hatch 命令画剖面线时，要作选择集，按照输入提示，用鼠标作选择

集，用鼠标作选择集时，按住鼠标左键，点击实体，如下图形所示。

Hatch(图案填充)
剖面线的字



用 Hatch

命令的不同方

式的选取与用

鼠标选取实体

的方式有关，

用鼠标作选择

集时，得到的

图形结果见左

面第四步中的

图形，这是用

第一种方式。

在选取填

充的方式后，

然后选取比例

因子，并且输

入角度，最后

用鼠标选取要

填充的实体。

注意选取

的实体方式不

同，得到的字

符嵌入方式也

不同。

一般选用

第四步图中的

方式，这样使

文字与图形可

以清晰分辨出

来。

4  用 Hatch命令得到一个画好剖面线的图形，得到的图形见下方。

5  除了上面一种剖面线画法以外，还有一种剖面线的画法，其方式见下图。

若按下列方式选取实体，图形则不同。

6  用第五步的方式选择实体后，得到的图形与用第三步选择实体的方式得到

的图形不同，得到的图形见下图。

7  总结：要画剖面线，要用到 Hatch命令，选择实体时有两种方式，方式不

同，图形状态也不同，要根据需要而定。



例 解例 解
Hatch（图

案填充）命令

的 Command

方式已介绍，

这里介绍它的

对话框方式，

主要是标准形

式。

Hatch 命

令的对话框方

式如右图，是

较为形象的一

种方式，界面

非常友好。对

话框中各项参

数的设定与在

Command 状态

下 的 情 况 一

致 ， 熟 悉

Command 状态

输入的读者使

用该对话框来

应该感到更方

便。可以用鼠

标选取菜单中

的各种方式，

得到所需的剖

面线。第三步

中的对话框中

包括了很多剖

面线。读者可

以根据需要用

鼠标选取，极

为方便。

1  Hatch命令的对话框方式如下图，其位置为 Draw →Hatch。

2  Circle命令在 Draw 菜单之中，为了画剖面线，要表现其不同方式，可以用

Circle命令画两圆如下图，画圆时，输入圆心为(0,0)，半径为 20及 40。

3  填充的方式有很多种，这些都是指其标准方式，可以点击“方式”或者对

话框中的 Pattern 项，出现下面对话框。

Hatch(图案填充)
截面圆筒



Hatch（图

案 填 充 ） 的

Command:命令

方式已介绍，

这里介绍其对

话框方式。其

对话框方式操

作起来极为方

便，在对话框

中 还 有 示 意

图。读者可以

通过示意图来

确定选用使用

哪一种方式，

这对于初学者

极有帮助。

本例中选

用的是斜线剖

面线，在选取

方式后可以设

置倾角为 30

度。

不同的选

择方式可以根

据对话框中的

不同参数的设

置看出来。

由本例可

见，选择实体

的方式不同，

效 果 确 实 不

同。

4  按对话框中的数字设置参数，并用 Pick points 方式，即鼠标选取实体。

5  按照菜单上的各参数状态输入参数后，选取实体后，点击对话框中的 Apply

键，则得下面图形。

6  用 Hatch 命令，即填充命令填充剖面后还要用点划线画出中心线，得到一

个标准的截面圆筒的图形，如下图形所示。

7  总结：要画剖面线，要用到 Hatch 命令。对话框方式比较简单，但速度较

Command 状态下的输入要慢。



例 解例 解
Bhatch 实

际上与 Hatch

命令的对话框

方 式 相 同 ，

Bhatch 命令的

对话框方式如

右图所示，界

面非常友好。

对话框中各项

参数的设定与

在 Command

状态下的情况

一致。

填充的方

式有很多种，

这些都是标准

方式，可以点

击“方式”或

者 Pattern 方

式，其对话框

见右面。可以

用鼠标选取菜

单中的各种方

式，得到所需

的剖面线。

在右面的

对话框中，选

取剖面线的填

充方式为 Nor-

mal，再点击

“OK”键。

1  在 Command:后键入 Bhatch命令，出现下面对话框。

2  为了用 Hatch对话框方式画剖面线，用 Circle 命令画三个圆。Circle 命令

在 Draw 菜单之中，用 Circle 命令画三个同心圆，直接用鼠标在作图区上

选取选取圆心及半径，如下图所示。

3  点击下图中的“高级选项”键，即“Advanced”键，出现下列对话框，并

用鼠标设置参数。

Bhatch(块填充)
套  筒



下面介绍

这个对话框，

单 击 “ Ad-

vanced”键后，

出现第三步中

所 示 之 对 话

框。在对话框

中最上面一排

有 三 个 示 意

图 ， 分 别 为

“ Normal ”，

“ Outer ”，

“Ignore”，这

是画剖面线的

三种方式，在

这三个提示前

用鼠标单击白

色的按钮，就

可以选择好所

要 方式，读者

可以自己试一

试。

当然，还

可以对界线进

行设置，即进

入 话 框 中 的

“ Boundary

set”选项设置

剖 面 线 的 界

线。这里没有

介绍实例，读

者可以自己试

一试。

4  下面用对话框方式进行剖面线作图，用上一知识点所示方法作剖面线，得

图形如下。

5  用 Bhatch对话框方式作剖面线时有几种方式。现换用一种方式，将第三步

的参数设为 Outer时，得下面图形。

6  用斜的剖面线画出套筒的类外剖面线，用 Line命令画点划线，表示套筒的

中心线，得到图形如下。

7  总结：要画剖面线，要用到 Bhatch 命令。选择实体时有两种方式，方式

不同，图形状态也不同，要根据需要而定。



例 解例 解
本例用到

的 命 令 有

Layer ， Re-

ctang，Circle，

Line，Hatch。

Layer 命令主

要用对话框方

式，Circle，Line

命令在 Draw

菜 单 之 中 ，

Hatch 命令也

可用对话框方

式。

用 Layer

对话框设置图

层时，对话框

中的每一项都

有 形 象 的 图

示。

在图层对

话框中最后两

项依次是颜色

设置和线型设

置，只要用鼠

标点击所需的

项，即可进入

设置。

Hatch 对

话框见右图。

对 话 框 中

“ Pattern”项

为一种设置方

式。

1  在 Command 后键入 Layer命令，出现下列菜单。用 Layer 命令设置图层，

并按下图方式定义各参数。

2  Layer 命令主要用对话框方式。用 Circle 命令，Rectang 命令画圆、矩形，

可以用鼠标直接在作图区上选取各点，画出下图所示的图形。

3  用 Hatch命令画剖面线，参数设置参见下面的对话框。

综合实例
螺旋配合



用 Layer

对话框设置图

层 的 各 项 参

数，例如颜色、

线型等，极为

方便，读者经

常要用到。

对于Hatch

命令，填充的

方 式 有 很 多

种，这些都是

标准方式，可

以点击“Type”

或者“Pattern”

项。

可以用鼠

标用选取菜单

中 的 各 种 方

式，得到读者

需 要 的 剖 面

线。

用 Hatch

命令选择实体

时 有 两 种 方

式，本例主要

用到第一种方

式。

可 以 看

出，选择实体

的方式不同，

得到的效果确

实不同。

4  用第三步的对话框方式设置参数后，用上一个知识点绘制剖面线，则绘出

剖面线的图形如下。

5  为了使螺旋配合更为逼真，要画一中心线，可以用 Line命令画中心线。

6  为了表示螺纹，用 Arc 命令画一四分之三圆弧，得到一个配合好的螺旋配

合，图形如下。

7  总结：要画剖面线，需要用到两个对话框方式，分别为图层对话框和填充

对话框，两者结合起来，才画出了本例的图形。



例 解例 解

          

本例用到

的命令有 Lay-

er，Line，Hatch

等。 Layer 命

令主要用到对

话框方式设置

参 数 ， Hatch

命 令 也 是 一

样。

用 Layer，

菜单设置图层

时，对话框中

的每一项都有

形象的图示。

在图层菜

单 中 的 显 示

中，前两项依

次是冻住图层

和解冻图层。

当选择冻住图

层时，该图层

被固定住，只

能用解冻选项

来解冻，否则，

不 能 改 变 图

层。

用 Hatch

命令设置剖面

填充方式时，

可以得到右图

所 示 的 对 话

框 ， 这 是 在

“Quick”方式

下操作。

1  在 Command 后键入 Layer 命令，得到下面的菜单。用 Layer 命令设置图

层，如下图所示。可以用“New”项建立新的图层。

2  为了画出管道的外形，可以用 Line 命令。Line 命令在 Draw 菜单之中，用

Line命令画内外管道，用鼠标直接在作图区上选取点的位置。

3  用 Hatch 命令画剖面线，在 Command 后键入 Hatch 命令，出现下面对话

框，按照图示对话框设置参数。

综合实例
管道配合



绘制时，

注意剖面线的

方向，即内外

管 道 不 要 画

错。用 Layer

对话框方式可

以很好地进行

人机对话，对

于 初 学 者 来

说，这是比较

好 的 一 种 方

式。

用到Hatch

命令时，填充

的方式有很多

种，这些可以

通过设置对话

框中的参数来

确定到底选用

哪种方式。在

ACAD2000 中

可选择的方式

更多了。可以

用鼠标选取菜

单中的各种方

式，得到读者

所 需 的 剖 面

线。

最后得到

的 图 形 见 左

图。注意，剖

面线的倾斜角

与所设参数之

间有较大的关

系。

4  用 Hatch 对话框方式设置各个参数，以绘制剖面线。注意上下剖面线方向

是相同的，绘制的图形如下。

5  为了使图形更为逼真，要画中心线。改变图层后，用 Line命令绘制中心线，

如下图所示。

6  为了表示内管道的内母线，可以用 Line 命令画一虚线。在画虚线时，要先

用图层菜单中的改变线型设置虚线线型，得到的图形如下。

7  总结：要画剖面线，要用到 Hatch 命令。选择实体时有两种方式，本例主

要用到第一种方式。
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